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1Getting Started with Technical Communication Suite 2
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GETTING STARTED

RESOURCES
Before you begin working with your software, take a few moments to read an overview of activation and 
the many resources available to you. You have access to instructional videos, plug-ins, templates, user 
communities, seminars, tutorials, RSS feeds, and much more.

ACTIVATION AND REGISTRATION
To review complete system requirements and recommendations for your Adobe® Technical 
Communication Suite software, visit www.adobe.com/products/technicalcommunicationsuite.

Install the software
1  Close any other Adobe applications open on your computer.
2  Insert the installation disc into your disc drive, and follow the onscreen instructions.

Help with installation
For help with installation issues, visit the Installation Support Center at 
www.adobe.com/products/technicalcommunicationsuite.

Activate the software
Activation is required if you have a single-user retail license of Adobe Technical Communication Suite. If you 
specify a serial number during installation, the suite is activated silently over the Internet when you launch 
a component product for the first time. No personal data is transmitted during activation. 

A single-user retail license activation supports two computers. For example, you can install the suite on a 
desktop computer at work and on a laptop computer at home. If you want to install the suite on a third 
computer, first deactivate it on one of the other two computers. Choose Help > Deactivate.

For more information, visit www.adobe.com/go/activation.
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2 Technical Communication Suite

Note: If you installed the suite in trial mode, click Help > Activate to activate it. You will be prompted for a serial number.

Register
Register your suite to receive complimentary installation support, notifications of updates, and other 
services. You need to register only once for Adobe Technical Communication Suite. 

To register, follow the onscreen instructions in the Registration dialog box, which appears after you install 
the software. 

Note: If you postpone registration, you can register at any time by choosing Help > Registration.

ReadMe file
A ReadMe file is available online and on the installation disc. Open the file to read important information 
about your software.

HELP AND SUPPORT
Community Help
Community Help is an integrated environment on adobe.com that gives you access to community-
generated content. This Help is moderated by Adobe experts and experts using Adobe products in 
industry. Comments from users help guide you to an answer. Search Community Help to find the best 
content on the web about Adobe products and technologies, including these resources:

• Videos, tutorials, tips and techniques, blogs, articles, and examples for designers and developers.
• Complete online Help, which is updated regularly and is more complete than the Help delivered with 
your product. If you are connected to the Internet when you access Help, you automatically see the latest 
online Help rather than the set delivered with your product.
• All other content on Adobe.com, including knowledgebase articles, downloads and updates, Developer 
Connection, and more.
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Use the help search field in your product’s user interface to access Community Help. You can search for 
content within Adobe.com site and also in relevant web sites that have useful information for your product. 
Moderators continue to identify most relevant web content for your product. You can add comments to 
online help and view comments added by other users. For a video of Community Help, go to 
www.adobe.com/go/tcs_community_help.

Adobe Help Viewer 2
Adobe Help Viewer 2 is an AIR application that seamlessly merges the online and offline experience. When 
online, you get the latest and most-updated product help pulled from the web. You can also access a PDF 
version of Help. When offline, you access Help installed with the product on your system. Adobe Help 
Viewer 2 has a user-friendly interface that supports advanced navigation features. For example, you can get 
quick overviews of topics through mini TOCs, change zoom-factor, or bookmark both locally available and 
online content for quick reference. 

Search feature supports an online- and offline-mode. Adobe Help Viewer 2 searches for content in 
Community Help when online or help installed with the product when offline. Online search suggestions 
offer relevant results from product help and websites—both Adobe.com and other websites. Offline search 
uses indexes to return preferred topics for key terms. 

You can use the commenting feature to add notes for your own references. We welcome your feedback on 
help content. Your comments can be uploaded to www.adobe.com.

Note: For a video of Adobe Help Viewer, see www.adobe.com/go/help_viewer2.

Other resources
Online Help also includes a link to the complete, updated PDF version of Help.

Visit the Adobe Support website at www.adobe.com/support to learn about free and paid technical 
support options.
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4 Technical Communication Suite

SERVICES, DOWNLOADS, AND EXTRAS
You can enhance your product by integrating a variety of services, plug-ins, and extensions in your product. 
You can also download samples and other assets to help you get your work done.

Adobe Exchange
Visit the Adobe Exchange at www.adobe.com/go/exchange to download samples as well as thousands of 
plug-ins and extensions from Adobe and third-party developers. These plug-ins and extensions can help 
you automate tasks, customize workflows, create specialized professional effects, and more.

Adobe downloads
Visit www.adobe.com/go/downloads to find free updates, tryouts, and other useful software. 

Adobe Labs
Adobe Labs at www.adobe.com/go/labs gives you the opportunity to experience and evaluate new and 
emerging technologies and products from Adobe. At Adobe Labs, you have access to resources such as 
these:

• Prerelease software and technologies
• Code samples and best practices to accelerate your learning
• Early versions of product and technical documentation
• Forums, wiki-based content, and other collaborative resources to help you interact with like-minded users
Adobe Labs fosters a collaborative software development process. In this environment, customers quickly 
become productive with new products and technologies. Adobe Labs is also a forum for early feedback. The 
Adobe development teams use this feedback to create software that meets the needs and expectations of 
the community.

Adobe TV
Visit Adobe TV at http://tv.adobe.com to view instructional and inspirational videos.
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ADOBE TECHNICAL COMMUNICATION SUITE 2 OVERVIEW
Adobe Technical Communication Suite software is an end-to-end solution for authoring, reviewing, 
managing, and publishing technical information and training content. You can use it to create and maintain 
technical documentation, user assistance systems, knowledgebases, simulations, software demonstrations, 
and other support information. 

The tight integration of component products in the suite enables true single-source authoring. You can 
author content once and publish it in multiple formats and languages. For example, you can author content 
in Adobe FrameMaker and output it in multiple formats using Adobe RoboHelp. 

You can also enrich content through interactive 3D models, rich media, multi-layered images, 
demonstrations, and embedded SWF movies to create engaging learning experiences. Using the cross-
platform Adobe AIR Help format, you can push updates to your Help content even after you have delivered it.

This latest release of Adobe Technical Communication Suite includes the following components:

• Adobe FrameMaker 9
• Adobe RoboHelp 8
• Adobe Captivate 4
• Adobe Acrobat® Pro Extended 9
• Adobe Photoshop CS4
You can use the powerful features in Adobe Photoshop CS4 to edit and enhance images and screenshots 
before using them in your Help projects. Further, if you want to capture some quick screenshots, you can 
use Adobe RoboScreenCapture, which is a component of Adobe RoboHelp 8 included in the suite. 

Adobe RoboHelp 8 also includes Adobe RoboSource Control, which lets you add Adobe FrameMaker or 
Adobe RoboHelp files to version control. RoboSource Control stores all your project files in a database, 
enabling other authors to access them. It also prevents more than one author from checking out a file at the 
same time.
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6 Technical Communication Suite

Top benefits of Adobe Technical Communication Suite
• Create, review, manage, and publish technical information seamlessly.
• Single-source from FrameMaker to PDF/Print and online Help formats.
• Publish your DITA projects to online Help formats, either directly through RoboHelp or through the DITA 
Open Toolkit (DITA OTK).
• Import review comments from PDF files into FrameMaker documents.
• Deliver your Help projects in the cross-platform Adobe AIR format. You can push updates to your Adobe 
AIR Help projects even after you have delivered them.
• Embed Adobe Captivate demos and simulations in online Help projects and PDF documents. You can 
also edit Adobe Captivate demos from within FrameMaker or RoboHelp.
• Reliably create, combine, and control Adobe PDF documents for easy, secure distribution, collaboration, 
and forms data collection.
• Capture screenshots using RoboScreenCapture; edit and enhance them in Photoshop CS4. You can also 
animate the different layers of a Photoshop image.
• Embed 3D models in FrameMaker that come to life when you publish to PDF.

Top features of Adobe Technical Communication Suite
Seamless single-source authoring Author content once in FrameMaker, link or import your FrameMaker 
files into RoboHelp, and then output multiple formats for delivery. 

• Add FrameMaker documents as live links in RoboHelp The RoboHelp Project Manager pod uses visual 
cues to help you identify the linked FrameMaker files whose source content has changed. You can right-
click the out-of-sync FrameMaker files and update the RoboHelp topics generated from them on-the-fly. 
While updating, you can choose to preserve the changes that you made directly to the generated RoboHelp 
topics.

• Save reusable project-level conversion settings You can save reusable project-level conversion settings 
for FrameMaker files in RoboHelp. These settings can include mapping information for paragraphs, 
character formats, cross-references, table and list styles, images, and so on. 
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• Robust support for FrameMaker content in RoboHelp You can specify the Cascaded Style Sheet (CSS) that 
you want RoboHelp to use for mapping styles with FrameMaker formats. Next, you can choose what 
FrameMaker formats map to which styles in the CSS. You can also create Dynamic HTML effects (DropDown 
Text and Expanding Text) in FrameMaker and publish them in the online Help formats using RoboHelp. 

The following table summarizes how major FrameMaker elements are converted in RoboHelp:

Files

Book files and TOC .fm, .mif, .htm, and .xhtml files contained within the book are converted. All other files 
in the book are ignored. TOCs are converted if you select them in your project import 
settings.

Text insets Text insets in the FrameMaker documents are considered part of the FrameMaker 
document, and are flattened in the RoboHelp topic.

Index and glossary Index and glossary files generated in the FrameMaker book are not converted. 
Instead, the index markers and glossary are converted, if you select them.

Formats, variables, and conditional text

Paragraph formats, character 
formats, tables, footnote 
properties, table footnotes, 
and lists

Converted.

Variables and conditional text 
tags

User-defined variables in FrameMaker are converted as such in RoboHelp and can be 
redefined. Conditional text tags are converted as RoboHelp conditional build tags.
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8 Technical Communication Suite

Markers

Cross-references, hypertext, 
and URLs

Converted to hypertext links. You can map the cross-reference formats in RoboHelp 
so that you can remove the volume, chapter, and page references that are not 
relevant in online format. URLs become live hypertext links in the online Help output.

Index and glossary markers Converted to an index and glossary when creating project. 

Topic name markers and topic 
alias markers

Converted if you select them in your project import settings. 

Custom markers Custom markers are converted to RoboHelp processing instructions. 

Page layout

Rotated text Converted to text, such as in table cells. (Rotated text is not supported in HTML).

Images and anchored frames

Anchored frames, images, 
drawings, text frames, and 
graphic frames

All contents within an anchored frame, such as drawings, text frames and graphic 
frames, are converted to a single image. 

Images are converted if they are inside anchored frames

ALT text on images and 
anchored frames

Converted. 
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For more details on how FrameMaker elements are converted in RoboHelp, see 
www.adobe.com/go/single_source_authoring.

Send PDFs for review Use the Save as PDF (Send for Review) feature in RoboHelp and FrameMaker to save 
a document as a PDF file, and send the PDF file for review by e-mail. Reviewers can add comments to the 
PDF if they have Adobe Reader or Adobe Acrobat Professional installed on their machines. 

Seamless review of technical content A key challenge that you face as a technical communicator is 
incorporating feedback from several rounds of review into your documents. Manually integrating 
comments and edits from multiple reviewers is tedious and prone to omissions. 

You can create a tagged PDF file from an unstructured or structured FrameMaker document and send it for 
shared review. Editors and reviewers add their comments to the PDF file, which you can import on-the-fly 
into the source FrameMaker document. Reviewers are not required to have Adobe Acrobat installed on 
their machines to add comments. They can add comments using the Adobe Reader software, which can be 
downloaded for free.

Imported comments are inserted as tracked text edits, tracked markers, or simple text formatting in the 
FrameMaker document. You can aggregate and review comments in Acrobat before you import them in 
FrameMaker. You can also specify advanced filters in FrameMaker to control the import of comments 
closely. Author, comment type, comment status, and insertion date are some parameters that you can use 
for filtering comments.

Structured FrameMaker components

XML, XHTML, and DITA Map 
files in the book

Converted.

Content references Text or files that you have inserted into the FrameMaker documents as content 
references appear as part of the topics where they appear. They do not appear as 
references in the online Help output. 
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10 Technical Communication Suite

After importing comments, you can accept or reject them in the FrameMaker document as necessary. The 
Markers pod in Adobe FrameMaker 9 makes it simpler for you to manage imported PDF comments.

Enhanced image-editing using Photoshop CS4 Capture images and screenshots for your Help projects 
using RoboScreenCapture and use the powerful features in Photoshop CS4 to edit and enhance them. You 
can also animate the different layers of a Photoshop image.

Add rich media content to your Help projects Creating engaging learning experiences was never easier! 
Create demos in Adobe Captivate and embed them in online Help projects and PDF files. You can launch 
Adobe Captivate from within FrameMaker or RoboHelp, initiate a new recording, and insert a demo on-the-
fly. You can also edit Adobe Captivate demos in either of these applications.

Acrobat Connect meetings Access the real-time, web-based collaboration capabilities of Acrobat.com. 
Click the Start Meeting button to escalate from a document review to real-time communication with others 
over the Internet.

When you first click the Start Meeting button, you can create a free trial account. Every subsequent time, 
you go directly to your Connect personal meeting room. You can launch ConnectNow from within all 
components of Adobe Technical Communication Suite.

WHAT’S NEW
Adobe FrameMaker 9
Adobe FrameMaker software is a robust authoring and publishing solution for technical communicators. 
FrameMaker simplifies the task of authoring volumes of content and enables users to publish content in 
multiple formats and languages from a single source. FrameMaker supports both unstructured and 
structured content workflows.

Interface enhancements
FrameMaker 9 has a new interface that includes these features:

Tabbed document windows Multiple open documents are organized into a tabbed document view for 
easy switching.

ug.book  Page 10  Sunday, November 9, 2008  11:57 PM



11Getting Started with Technical Communication Suite 2

W
h

at
’s

 n
ew

Pods Pods are panes that can float anywhere in the FrameMaker workspace. FrameMaker 9 provides pods 
for some of the most frequently used features, such as conditional text, cross-references, markers, variables, 
fonts, and insets.

Tabbed and dockable panels Most commonly used dialog boxes have been converted to modeless 
panels that can be docked, stacked, minimized as you work in FrameMaker.

Toolbars Commonly used icons are now available in new toolbars for text, table, and paragraph formats; 
graphics; object alignment and properties.

Predefined and customizable workspaces Default workspaces for various workflows, such as structured 
authoring, review, or DITA authoring are introduced. You can create custom workspaces by moving and 
manipulating the document windows and panels.

Pods
The following most frequently used dialog boxes have a new interface designed to simplify your work:

Conditional text pod  Manage conditions in a document from a single pod. Create or edit conditions, 
apply conditional criteria to documents, and view versions based on conditions.

Cross-references pod Manage cross-references in a selected document or all open documents. Add, edit, 
and troubleshoot internal and external cross-references across multiple documents from a single pod. 

Marker pod Manage markers in the selected or all open documents. Add, edit, search, and troubleshoot 
all types of markers in a document from a single pod. 

Fonts pod  Lists the fonts including combined fonts used in a document. The Replace Font pod lists the 
pages where a font is used making it easier to swap unavailable fonts across selected or all open 
documents. 

Insets pod Manage and troubleshoot insets in a document including text insets, graphics, and 
multimedia objects imported by reference or copied into documents.

Variable pod Create, insert, edit, and convert variables to text, refresh and delete variables. Perform any 
of the variables-related operation using the variables pod.

ug.book  Page 11  Sunday, November 9, 2008  11:57 PM



12 Technical Communication Suite

DITA
FrameMaker 9 has enhanced support for DITA 1.1. Some of the key DITA-related enhancements are as 
follows:

• New dockable user interface for editing and managing DITA maps and bookmaps like a FrameMaker 
book. 
• Enhanced support for <xrefs> and <conrefs> including support for non-textual elements, such as 
graphic objects, tables, and table components as well as <conrefs> from DITA maps. 
• Conditional processing through a DITAVAL file to create custom outputs. 
• Enhanced support for relationship tables and <lockTitle> attributes.
• DITA indexing specialization allows for Index, See, and See Also entries.
• Ability to save a DITA map as a composite FrameMaker document for further processing. You can directly 
print a composite document to a PDF without using DITA Open Toolkit.

Book enhancements
The book feature has been considerably enhanced in FrameMaker 9. You can create mixed hierarchical 
books that can include .xml and .mif files, folders, groups, and child books at multiple sub levels.

Mixed books You can now include multiple file types, such as .xml and .mif files along with .fm files in a 
book. Structured FrameMaker provides full support for .xml files, including the ability to specify conditional 
text and numbering information.

Folders You can use folders in a book to organize files and set numbering properties on a folder. You can 
include multiple folders within a folder as well as associate templates with a folder. A folder, depending on 
where it appears in the book hierarchy, works like a chapter, section, or sub section with subordinate 
components within it.

Groups You can also organize files into groups for additional processing. 

Book in a book You can now include a book within a book to build a complex hierarchical parent book. 

Bookmaps and DITA maps in a book You can also include XML maps, such as bookmaps and DITA maps 
in a book. 
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Search Search and replace works on all book components except child books, ditamaps, and folder 
templates.

Section and sub section numbering You can use new variables <$sectionnum> and <$subsectionnum> 
to set numbering properties for book components at the section or sub section level. 

Exclude property You have the flexibility to exclude selected files from publishing by setting its Exclude 
property.

Saving hierarchical books You can save a hierarchical book as .mif files, .xml or SGML files, HTML, 
FrameMaker 8 book file, or as a PDF. The hierarchical structure of a book is preserved when it as a PDF but 
flattened in a depth first traversal order when you save it as HTMLs.

PDF comments
FrameMaker 9 provides the ability to import comments and text edits, such as additions, deletions, and 
replacements from a tagged PDF into your source FrameMaker files. You can import the following types of 
comments into a FrameMaker 9 document:

• Sticky notes
• Highlights
• Highlights with comments
• Text additions 
• Text replacements
• Text edits, such as underlines
• Text deletion or strikethrough
Comments are inserted as tracked text edits or tracked markers that you can accept or reject as required.
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Enhanced access to files using their HTTP paths
FrameMaker is IPv6 compliant and supports IPv6 URLs. FrameMaker also supports HTTP paths ubiquitously 
in all its workflows. You can create, open, save, update, check-in, and check-out files directly on a WebDAV 
enabled server by specifying the HTTP path of the file through the Browse URL dialog box. This feature 
provides a quicker and a more intuitive way of working with files on stored on remote WebDAV enabled 
servers. You can access and cross-reference all FrameMaker supported files including graphics by 
specifying the HTTP path of the file.

Character palette and Hex input palette
Unicode support in FrameMaker 9 has been extended by the introduction of a UTF-32 enabled character 
palette and Hex input palette to enter Unicode characters in a document.

Adobe RoboHelp 8
Adobe® RoboHelp® 8 software is designed for developing help systems, eLearning content, policies and 
procedures, and knowledgebases. Its enhanced editing and layout capabilities enable you to create 
professional looking content, which you can publish to multiple channels, including Adobe AIR™ for an 
integrated online and offline user experience.

Authoring enhancements
XHTML support RoboHelp creates topic files in XHTML and project-specific files in XML. Structured 
authoring in XHTML ensures well-written code, closed tags, no overlapping of tags, properly quoted 
attributes with explicit values, and no proprietary attributes. RoboHelp upgrades all the old RoboHelp 
HTML topics to XHTML when it upgrades or imports them. 

You can import an XHTML or HTML topic from the File menu and open the topic for editing directly in the 
HTML view.

Enhanced editing support in Design Editor The enhanced Design Editor in RoboHelp 8 lets you use 
advanced list and table styles, drag and drop text in tables, and merge and split table cells. It provides clean 
code with no proprietary tags. All the RoboHelp specific code is in the form of XML standard processing 
instructions (PIs). 
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World Wide Web 3 Compliance (W3C) RRoboHelp 8 provides an option to validate topics and project for 
W3C compliance. It displays error messages or warnings that appear for any non-compliance with W3C. 

List and table enhancements RoboHelp 8 supports advanced lists, and autonumbers. You can apply list 
styles to provide different appearances to lists. 

Enhanced table support allows you to insert columns and rows in a table, and cut, copy and paste columns, 
rows, and cells. You can merge and split cells and insert a table within a table.

Insert HTML comments, IFrame You can insert an HTML comment at any location in a topic. These HTML 
comments are added in a particular format and viewed in a pop-up window. 

You can insert an IFrame in an HTML topic to include another HTML page or PDF file in it. You can also access 
URL links to view a web page in an IFrame. 

Import enhancement features
Project-based common import settings Create a standard set of conversion settings for importing Adobe 
FrameMaker® or Microsoft® Word content into RoboHelp projects and use these settings across multiple 
projects. These settings include Adobe FrameMaker or Word templates; cascading style sheets (CSS) for 
RoboHelp project; style mapping between FrameMaker formats or Word styles and RoboHelp styles; and all 
other settings specified in the Conversion Settings dialog box.

Direct import of HTML or XHTML files You can import HTML or XHTML files directly from File > Import > 
HTML/XHTML File.

Enhanced FrameMaker document import In RoboHelp 8, you can import and link FrameMaker 8 and 9 
books. 

RoboHelp 8 maintains content integrity for imported FrameMaker content. RoboHelp retains lists, tables, 
images, SWF content, conditional text, variables, TOC, index, glossary, and user-defined markers as 
Processing Instructions (PIs). Enhancements in importing FrameMaker files allow for:

• Enhanced Add or Import settings from a common user interface
• New workflow
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• FrameMaker template support
• Import styles for style mapping (table styles, list styles, and image settings)
• Enhanced import of vector graphics
• Import of Alt text for anchored frames
• List conversion option for each style
• Import and export of settings
• Pagination on FrameMaker styles
• Custom HTML tag for each style
• Ignore empty topics (after pagination)
• Project upgrade
Enhanced Word document import and linking RoboHelp enables you to include Microsoft Word 
document formats (*.doc, *.docx, *.docm, *.rtf) as source files in RoboHelp 8. You can add Microsoft Word 
documents to a RoboHelp project, update them when the Word documents change, and generate different 
single-source outputs. The source documents as well as generated topics, CSS, images, multimedia, the 
TOC, the index, and the glossary are visible in RoboHelp. You can manage, preview, sync, and control Word 
documents from RoboHelp. You can link Microsoft Word documents in RoboHelp by copy or reference. 

DITA content import RoboHelp 8 allows for the import of a DITA Map File or a DITA topic into an existing 
RoboHelp project. You can also import a DITA Map file to create a RoboHelp Project and publish the desired 
output.

Single sourcing features
New CSS editor The styles editing interface is new, allowing for changing the most common properties 
quickly. The new style editor enables you to define new styles such as lists and table styles. You can define 
multi-level lists and autonumbering in the style editor. Using the Style editor, you can change images in 
twisties, and drop-down and expanding hotspots.

Styles and Formatting pod The Styles and Formatting pod enables you to apply styles and lets you access 
the style editor to create a style or edit a style.
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Master page support Master pages separate content from the layout. Master pages also act as a template 
for a particular HTML topic. In RoboHelp 8, you can define the placement of headers, footers, and HTML text. 
You can add placeholders for breadcrumbs and mini TOCs in master pages.

Resource Manager pod Resource Manager stores all the common resources to use across projects and 
allows for quick access and management of common resource files. 

Apply master pages or CSS in SSL Single-source layouts let you override master pages or the CSS at the 
time of generation of output. For different output results, you can apply different master pages or a 
different CSS to all the topics in a project.

Publishing features
Adobe AIR The Adobe AIR output type allows you to generate Help in Adobe AIR format. Generate your 
content in the cross-platform Adobe AIR Help format that brings a host of enhancements, such as these:

• Easy navigability through breadcrumbs, and more
• New templates and skins
• A rich branding experience, and the ability to insert corporate logos and an About box in Help
• Rich commenting and auto-update functionalities
• Browser Based Help, availability of Online and Offline Content
• Ability to add and access RSS feeds
• Enhanced search functionalities
Search enhancements New RoboHelp search supports the following features:

• Ranking of search results
• Keyword search
• Synonym search
• Excluded topic search
• Multiple-language search
• Substring search
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• Phrase search
• Customizable search results search list
• Topic context in search list
• Baggage file search
Merged Project enhancements Merged project enhancements introduce the concept of child project 
referring to master TOC. Child projects auto sync with the merged TOC and you can see the merged TOC in 
the child projects.

Breadcrumbs and mini TOCs Use placeholders for breadcrumbs and mini TOCs in master pages and 
topics. Generate or preview Help to automatically insert the breadcrumbs and mini TOCs. 

Twisties Use twisties in the CSS editor to enhance glossary terms, drop-down, and expanding text. You 
can change images in twisties for open and close. RoboHelp displays glossary terms, drop-down text, and 
expanding text with images to expand or collapse them.

Productivity features
Scripting support  In RoboHelp 8, you can create your own scripts to automate repetitive tasks and key 
workflows, which are time consuming to do manually. The Script Explorer pod enables you to execute and 
manage scripts and you can execute your scripts using the command line parameters. 

RoboHelp provides a set of sample scripts that you can use right away or customize for your needs. You can 
access these sample scripts, such as UDV converter, or Link converter or create your own scripts using the 
Script explorer pod.

Integration with Adobe Captivate 4, RoboSource Control 3.1, and Robo-ScreenCapture Create and edit 
Adobe® Captivate™ 4 demos and simulations from within the RoboHelp HTML application. 

While installing RoboHelp HTML 8, you get an option to install RoboSource Control 3.1 to control the 
versions of projects.

You can open and edit images using RoboScreen Capture from within the RoboHelp HTML application.
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Custom To Do list RoboHelp 8 helps you manage a To Do list, facilitating addition, and deletion of to do 
items from the project. By default, RoboHelp 8 supports 11 To Do list items. You can customize the list items 
by adding or deleting to do items.

Usability features
Project Manager enhancements In the Project manager pod, you can customize the ordering of topics in 
folders to define a chapter layout for the project. The Auto-create TOC feature uses the ordering to create 
a logical TOC. You can sort the order of folders and topics alphabetically. 

Support for Adobe Flash videos In RoboHelp 8, you can insert FLV files and play them in Flash Player 
provided with RoboHelp 8.

Adobe Captivate 4
Adobe® Captivate® 4 software is packed with new features that help you work faster, collaborate more 
effectively, and create more realistic and engaging eLearning content with advanced interactivity, software 
and scenario simulations, quizzes, tables of contents, widgets, and more—all without programming or 
multimedia skills.

SWF commenting Accelerate content creation cycles with real-time reviews in Adobe Captivate Reviewer, 
an Adobe AIR™ application. Reviewers can add comments to your SWF files while playing them without 
having Adobe Captivate installed,and comments will be imported to the appropriate slides in your project.

Project templates Use enhanced project templates that make it easy for subject-matter experts to 
contribute instructionally sound content without compromising structure.

Customizable widgets Create more compelling learning experiences by including widgets such as 
games, question types, and more. Widgets can be created in Adobe Flash Professional software, easily 
shared via Adobe Exchange, and customized to meet your content needs.

Roundtrip PowerPoint workflow Leverage existing PowerPoint 2007 (PPTX format) slides in your 
projects. Import slides with audio and  interactivity, easily update the imported content from Adobe 
Captivate, and keep your PowerPoint and Adobe Captivate files in sync with the linked import option.
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Table of Contents and Aggregator Enable learners to easily navigate through content and track their 
progress with a multi-level Table of Contents. Also, use the Aggregator to combine multiple content 
modules to create a complete eLearning course.

Text-to-speech functionality Keep learners tuned in to your content thanks to automatic voice-over 
functionality that turns text to high-quality speech.

Variables and advanced actions Use Variables to personalize the learning experience by using learner-
provided data, such as the learner’s name, throughout a scenario. Use Advanced Actions to further 
configure and modify the experience by enabling conditional actions, or more than one action in an 
interaction. 

Expanded output options Embed Adobe Captivate movies in Adobe PDF files to enliven text-based 
instructional content, or embed your movies in Adobe Flex content using ActionScript 3.0 publishing. 
Output AVI files for streaming on the web or publishing to YouTube™. 

Adobe Photoshop layer support Preserve layers in imported Adobe® Photoshop® (PSD) files so you can 
easily edit or animate individual image areas for just the right effect.

Streamlined workflows and enhanced usability Enjoy workflow and usability enhancements, including 
inline editing of text captions; design templates to standardize the look and feel of projects; support for 
panning to optimize viewing on small screens and devices; support for right-clicking in simulations; 
drawing tools and image-editing; improved accessibility features; and more.

Adobe Acrobat 9 Pro Extended 
Adobe Acrobat 9 Pro Extended software lets you deliver the richest and most engaging PDF 
communications anywhere, anytime. Use it to deliver the widest range of content in a single compressed 
and organized PDF Portfolio. Collaborate through shared document reviews, create interactive forms, and 
collect data easily from respondents. Also protect your sensitive information by closely controlling access 
to it.
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PDF creation, editing, and searching
Unify a wide range of content into a PDF portfolio Combine documents, drawings, e-mail, and 
spreadsheets into a single, compressed PDF Portfolio. Use professionally designed templates that can be 
branded with your logo and include descriptions to guide recipients through the contents.

Convert paper documents to PDF: New optical character recognition (OCR) technology and support for a 
broader range of scanners improves searchability and appearance of the scanned documents.

Convert web pages to PDF Improved web capture allows you to convert complete web pages or just the 
portions you want, including or excluding rich and interactive media. PDF versions of web pages are easy 
to print, archive, mark up, and share.

Compare PDF documents Acrobat automatically highlights the differences between two versions of a 
PDF document, including text and images, so you can quickly and easily identify what has changed.

Search across multiple PDFs  Enhanced functionality enables you to search multiple PDF files in the same 
folder to help you quickly find the information you need.

Collaboration
Use Acrobat.com for shared reviews Participants download the file from Acrobat.com, and add 
comments or data using Acrobat or Adobe Reader. When finished, participants publish comments or 
submit responses to Acrobat.com. When using Acrobat.com for shared reviews, you can also allow 
reviewers to open and share the PDF in a live chat session.

Collaborate in online meetings Use Adobe ConnectNow, a personal web-conference tool, to conduct 
real-time meetings on your desktop.

Use Acrobat.com to upload and share large documents From Acrobat or Reader, you can create your 
own user account on Acrobat.com. Use Acrobat.com to upload and share most document types, and to 
share PDFs or your desktop in online meetings.

Synchronize document views Ensure colleagues, clients, and partners are on the same page at the same 
time with the ability to co-navigate documents. Use Collaborate Live to provide clarity, enhance discussion, 
and walk recipients through a document in real time.
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Forms
Easily create and edit electronic forms Use the new Forms Wizard to convert Microsoft® Word and 
Microsoft Excel documents or scanned paper into PDF forms. Form fields are automatically recognized and 
converted to fillable fields. Quickly add, edit, and name form fields. Use the Tracker to see when forms have 
been completed and who has completed them.

Collect and export form data Easily collect user data and export the data to a spreadsheet for analysis and 
reporting.

Track forms Use the Tracker to see when forms have been completed and who has completed them.

Use QuickBooks data in forms (English only) Import and export Intuit QuickBooks data using custom 
templates.

Multimedia and 3D models
Include Flash content in PDFs Add Flash® videos and animations to your PDF documents. Native support 
for Flash enables reliable cross-platform playback. No additional media player is necessary.

Add comments to videos: Add comments to a video as you are watching it. Each comment is attached to 
a specific frame, so that when you view the comments, they appear in the context in which they were made. 
You can also enable Acrobat Standard and Adobe Reader users to add comments to videos.

Create interactive presentations Use Adobe Presenter to liven up your slides with video, voice-over, 
demos, and interactive quizzes, then convert to PDF for easy sharing. Adobe Presenter installs with Adobe 
Technical Communication Suite if you already have Microsoft PowerPoint installed on your machine.

Expanded 3D features Use the new Adobe 3D Reviewer to combine multiple CAD formats into one 
assembly, compare a revised design to an earlier version, measure and section on precise geometry, and 
create exploded views, animations, and balloons. Export your work to 2D vector or raster files, or save as PDF.

View and interact with PDF maps Import, measure, and mark up geospatially enabled PDF maps. 
Discover the longitude and latitude by placing your cursor over a location. Measure PDF maps in kilometers 
or miles. Navigate 3D PDF map content in 3D with the Fly tool for better relational map viewing. Georegister 
PDF maps.
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Legal
Search and redact Search and redact a list of words or phrases or a specific text pattern (for example, 
phone numbers, credit card numbers, e-mail addresses, or dates).

Bates numbering for PDF Portfolios When designating documents for Bates numbering, you can add 
PDFs, PDF Portfolios, and any non-PDF files that can be converted to PDF. The process converts non-PDF 
file types to PDF, and then adds Bates numbers to the resulting PDF. If you add Bates numbering to a PDF 
Portfolio, any non-PDF files in the PDF Portfolio are replaced with the converted and numbered PDFs.

Creative professional
Output preview enhancements Use the Object Inspector to quickly inspect content in a document. The 
information displayed is for all content that is directly underneath where the cursor is clicked.

Preflight enhancements Validate PDF/E compliance and save documents as PDF/E. Run checks and fix-
ups on selected objects. View improved reports.

Color conversion enhancements Set the transparency blending space. Remap spot colors using the 
Pantone library. Easily convert colors using the new design.

Adobe Photoshop CS4
Adobe Photoshop is the industry benchmark for digital image editing. It is the essential software for 
perfecting images and is ideal for professional photographers, serious amateur photographers, and graphic 
designers. This new release features numerous enhancements that help you unleash your creative 
potential to the fullest.

Adjustments panel Quickly access the controls you require to nondestructively adjust image color and 
tone in the Adjustments panel. Includes on-image controls and presets in one location.

Masks panel Quickly create precise masks. The Masks panel offers tools and options for creating editable 
pixel- and vector-based masks, adjusting mask density and feathering, and selecting non-contiguous 
objects.
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Advanced compositing Create more accurate composites using the enhanced Auto-Align Layers 
command. The enhanced Auto-Blend Layers command smoothly blends color and shading, and extend 
your depth of field by correcting vignettes and lens distortion.

Canvas rotation Click to smoothly turn your canvas for nondestructive viewing at any desired angle..

Smoother panning and zooming Gracefully navigate to any area of an image with smoother panning and 
zooming. Maintain clarity as you zoom to individual pixels, and easily edit at the highest magnification with 
the new Pixel Grid.

Better raw processing in Camera Raw Apply corrections to specific areas of an image using the Camera 
Raw 5.0 plug in, enjoy superior conversion quality, and apply postcrop vignettes to images.

Efficient file management with Adobe Bridge CS4 Enjoy efficient visual asset management with Adobe 
Bridge CS4, which features faster startup, workspaces that suit the task at hand, and the ability to create 
web galleries and Adobe PDF contact sheets.

Powerful printing options The Photoshop CS4 print engine provides tight integration with all the most 
popular printers, the capability to preview out-of-gamut image areas, and support for 16-bit printing on 
Mac OS.

Better performance with large images Work faster with large images by taking advantage of additional 
RAM. (Requires a 64-bit computer with a 64-bit version of Microsoft Windows Vista).
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